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Message from the Chair, Department of Nursing and Health 
 
Welcome to Benedictine University and to the Department of Nursing and Health.   We are 
pleased to have you join us as a member of our community.  This Handbook has been 
developed to help you better understand our educational mission and, in particular, our 
program. 
 
Started in 1981, Benedictine University’s BSN Completion program is one of the first of its 
kind in Illinois.  The program combines the foundation disciplines of professional nursing 
with a high degree of responsiveness to local needs and changing circumstances.  
Throughout its offerings, the program seeks to produce graduates who will contribute to 
meeting the health care needs of tomorrow.  To that end, we support the qualifications of 
our students academically, professionally and personally. 
   
We commit our best efforts to you.   We expect that you, as adult students, will become 
familiar with the policies and procedures that govern your degree completion.  We want 
you to be successful and invite you to call upon us to support you in achieving your 
educational goals. 
 
Again, we look forward to working with you. 
 
Sincerely, 

 
Ethel C. Ragland, EdD, MN, RN 
Chair, Department of Nursing and Health 
 
 
 
 
This student handbook is intended to inform BSN students about Benedictine University 
(BU), in general, and the Bachelor of Science in Nursing (RN to BSN Completion) 
program, in particular.  It does not replace official University policies or the current BU 
Undergraduate Catalog.  This handbook does not constitute legal advice and should not 
be used as such.  You are invited to contact your academic advisor or the Department of 
Nursing and Health office if you have further questions. 
 
 
 
 
 
 
 
 
 
 
. 
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Overview of the Nursing Program 
 
The Mission of Benedictine University  
 
Benedictine University (BU) is dedicated to the education of undergraduate and graduate 
students from diverse ethnic, racial and religious backgrounds. As an academic community 
committed to liberal arts and professional education distinguished and guided by our 
Roman Catholic tradition and Benedictine heritage, we prepare our students for a lifetime 
as active, informed and responsible citizens and leaders in the world community 
The Department Mission 
The Department of Nursing and Health of Benedictine University is committed to the 
education of practitioners for professional nursing practice.  This education occurs in an 
environment of intellectual inquiry, personal accountability, and cultural, racial and religious 
diversity.  These practitioners are prepared to assume a pro-active role in their profession 
and in complex, evolving, health care systems. 
Program Goals/Outcomes 
The goals of the nursing program are to: 
 

1. Prepare liberally educated professional nurse generalists; 
2. Prepare the student, as a life-long learner, with a firm foundation for graduate study; 
3. Enhance the socialization of the student as a member of the profession. 

 
By completion of the program, the student will be able to: 
 

1. Synthesize knowledge from nursing, the humanities, and the natural and social 
sciences in professional practice.  

2. Demonstrate skills in critical thinking and decision making in the use of 
nursing process with individuals, families, groups and communities.  

3. Evaluate research findings to guide professional practice of nursing.  
4. Provide health education for individuals, families, groups and communities. 
5. Communicate effectively with individuals, families, groups, communities 

and other health professionals in promoting health planning and directing 
client care. 

6. Assume responsibility and accountability for own decisions and actions in 
 professional practice.  
7. Use leadership skills and knowledge of the political system to advance 
 professional nursing practice and health care in various settings.  
8.  Integrate professional values and ethical, moral and legal aspects of 
 nursing into own professional practice.  
9. Use a process of continuing learning in the development of one’s self, 
 nursing practice, and the profession. 
10. Demonstrate evolving competence in professional role within a changing,  
 multicultural society.  
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Accreditation 
 
The Commission on Institutions of Higher Education of the North Central Association of 
Colleges and Schools accredits Benedictine University. The Nursing program is accredited 
by the Commission on Collegiate Nursing Education (CCNE) through 2013. A link to 
CCNE’s website is available through the Department’s website  http://www.ben.edu/nursing 
 
 
BSN Curriculum  
 
Catalog Description of Requirements 
 
Nursing majors must: 

1. Meet University core requirements;  
2. Hold a current, valid registered nurse (RN) license in Illinois; 
3. Successfully complete the following courses or their equivalent: 

BIOL-203(4); BIOL-208(4); BIOL-258(4); CHEM-C101 (3); PHIL-C240 (3); PSYC-
C100 (3); PSYC-C200 (3) OR PSCYC-C202; SOCL-C100 (3); 

4. Successfully complete the following courses with a grade of “C” or better: 
NRHL-200(3); NRHL-213(3); NRHL-250(3); NRHL-290(3); NRHL-295(3); NRHL-
300(3); NRHL-301(4); NRHL-311(3); NRHL-320(3); NRHL-378 (3); 

5. Show evidence of current TB test, proof of immunizations, and other health 
requirements, and criminal background check prior to planned clinical/field 
experience(s); (See advisor for further information) 

6. Demonstrate computer proficiency (word processing, e-mail, internet use) as 
evidenced by transcripts, employer documentation, or student documentation. 

 
 
Schedules/Tuition 
 
The nursing major is offered in an accelerated cohort format designed for the adult learner. 
Currently, the program is offered at the College of DuPage (COD) in Glen Ellyn, IL, Triton 
College in River Grove, IL. and Memorial Medical Center, Springfield, through Benedictine 
University at Springfield.  The 31 credits in the major and 6 credits in the common core are 
scheduled over one calendar year. Schedules and tuition costs are posted on the 
Department website.  
 
Course Descriptions  
 
The nursing major (NRHL) courses are: 
 
NRHL 200 Nursing Transitions is the first of nine nursing courses and builds upon prior 
learning from the behavioral sciences and the humanities.  The foundation for subsequent 
nursing courses is provided by introducing the learner to the concepts of professional 
nursing practice environment. (3 credits) 
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NRHL 213 Health Aspects of Aging focuses upon the normal aging process in American 
Society including biological, psychological, and health aspects.  The course emphasizes 
health services, health maintenance, and contemporary issues with respect to the elderly 
population. (3 credits) 
  
NRHL 250 Statistics strives to make students better consumers of descriptive and inferential 
statistics with emphasis on statistics gathered for studies in nursing and health care. This 
course gives students the statistical background they need for the Research course. (3 
credits)  

 
NRHL 295 Research introduces the students to the research process.  Emphasis is placed 
on understanding the components of the research process and critically reading published 
research reports. (3 credits) 

 
NRHL 290 Health Assessment is a course that presents the client in a holistic manner 
when assessing the individual’s health status.  Opportunities are provided for integration of 
this course’s content and the knowledge gleaned from previous humanities, natural and 
social science courses and the integration with the RN student’s previous and current 
nursing assessments. (3 credits) 
 
NRHL 300 Holistic Nursing emphasizes holistic nursing assessments, interventions, and 
holistic nursing diagnosis for individuals experiencing acute or chronic health problems.  (3 
credits) 

 
NRHL 301 Family Health Nursing provides a foundation in the concepts and theories of 
family health care nursing.  Clinical experience within the varied settings provides the 
opportunity to apply the nursing process when delivering health care to families. (4 credits) 

 
NRHL 311 Community Health Nursing explores the physical, social, economic, and 
environmental factors which affect the health of a community. The nursing process is 
applied to groups and communities. (3 credits) 

 
NRHL 320 US Health Care System provides a multi-disciplinary examination of various 
aspects of the existing health care industry in the US.  The course examines the impact of 
managed care on process and outcomes and the governmental and economic influences 
on the system.  This course may be offered online. (3 credits) 

 
NRHL 378 Management focuses on the functions of management within a rapidly changing 
health care environment. Emphasis is placed on current issues impacting leadership and 
management within the context of specific practice situations. (3 credits) 

 
NRHL 395 Nursing Elective is a course designed to provide an individualized learning 
experience in theoretical or clinical aspects of nursing. Students are expected to develop 
objectives for their learning experience, strategies that facilitate achievement of the 
objectives, and criteria with which to evaluate the achievement of objectives. (1-4 credits) 
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Academic Policies, Procedures, and Resources 
 
Registration and Billing 

 
As a member of a nursing cohort, you will be block enrolled per term and automatically 
billed by the system.  
 
Lisle Students: All 37 credits delivered in the cohort are billed at the discounted rate of 
50% of regular adult undergraduate tuition. Any additional courses taken through BU’s 
Adult Undergraduate program are billed at the regular adult undergraduate tuition rate. 
Your due dates and payment options are the same as BU’s traditional students. The 
major difference being that instead of only having one due date at the beginning of the 
term (tuition is due 7 calendar days after the start of classes), you will have multiple due 
dates depending on when your class begins. In addition, a onetime yearly lab fee of 
$27.50 is charged to cover professional liability insurance. To register for any BU course 
not offered in the cohort, contact your academic advisor who will process a course add. 
 
If you would like to enroll in a payment plan, please contact BU’s payment plan provider, 
Sallie Mae to enroll in the Tuition Pay Plan. You can do this at www.tuitionpay.com or 
by calling (800) 635-0120. You should be enrolling in either the Annual Plan (to include 
Fall and Spring classes) or the Fall Plan (for only Fall classes). A small enrollment fee 
applies.  
 
You may also qualify for the Employer Reimbursement Plan (this needs to be approved 
by Student Accounts). If you have questions regarding your payments or payment 
options, please contact either the Student Accounts Office at (630) 829-6503 
(sar@ben.edu) or Laura Lucado at (630) 829-6408 (llucado@ben.edu). 
 
Springfield Students: billing and registration processes may differ some somewhat for 
Springfield cohorts.  All Springfield students should contact Kelly Schultz in Student 
Accounts at 217-525-1420, ext. 236 (kschultz@sci.edu.)  for processes specific to 
Springfield. 

 
 
Academic Advising 
 

Your acceptance letter will advise you to contact your advisor for an initial advising 
appointment. During this appointment you will register for courses offered in the cohort, 
review your BSN checklist, and receive a Student Plan of Study. These documents (see 
attached) will outline all courses you will need to graduate and designate your academic 
advisor. 
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Progression/ Grading System 
 
The University uses the following grade point system to evaluate student performance: 
A 4.00 Excellent  F 0.00 Failure 
B 3.00 Good   I  Incomplete* 
C 2.00 Satisfactory  W  Withdrawals 
D 1.00 Passing  X  Deferred** 
 
* Must be initiated by the student through the Registrar’s office. 
** Initiated by the instructor for administrative reasons. 
 
Faculty assign grades based upon students’ performance and completion of all course 
requirements. The grading scale for all* NRHL courses is:  
 
A = 92-100    B = 82-91    C =75-81    D = 68-74    F = below 68 
 
* with the exception of NRHL 250 Statistics which is listed on the syllabus  
 
Final Grade Report Policy 
 
Final grades can be accessed online via BenUConnect. Grades can be viewed and printed 
using the "View Grades" option in MyBenU. By following the print instructions (see 
below), a comprehensive grade report along with the University seal and logo can be 
printed. This official grade report can be used for tuition reimbursement programs. 
Some companies will allow you to log onto BenUConnect with a company representative 
present to verify grades for an individual term. Grades are only released through BenUConnect. If 
courses are in progress or not yet graded, the grade will appear as "IP". The In Progress grade 
does not impact the grade calculation. Grades are available only through BenUConnect and not 
sent through the mail. If you have any questions about the grade report policy, please feel free to 
contact the Registrar's Office at 630-829-6349 in Lisle or 217-525-1420, ext. 238 in Springfield. 
 
Navigation to View Grades via BenUConnect 
 
Before viewing your grades you must create a password. 

1) Go to www.ben.edu 
2) Click on MyBenU  
3) Click on Student password reset  
4) Enter 7-digit BU login username provided and the requested information 
5) Submit 

 
How to view your grades/unofficial transcript 

1) Go to www.ben.edu/BenUConnect 
2) Click “logon to BenUConnect” 
3) Login by using your username/ID provided and your password 
4) Click on MyBenU. When you log on to MyBenU, the MyBenU homepage appears. 
5) Enter stuben\b along with your username/ID and password you previously entered. 
6) Click on “SA Self Service” – A page will appear with options for self-service. 
7) Click on “Learner Services” – A page will appear with options for learner services.  
8) Click on “Academics” – A page will appear with academic options.  
9) Click on “View My Grades” – The grade report for the current term will appear.  If you wish a 

grade report from another term, click on “Select a Different Term” – A page will appear 
which lists all terms in which you have enrolled. Select the appropriate term.   
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10) To print the grade report, click File > Page Setup and select the Landscape 
Orientation option.  

11) To print the grade report with the University seal, one must, on the browser 
toolbar, click Tools > Internet Options > Advanced Tab. Then scroll down to the 
printing options near the bottom and make sure the “Print background colors and 
images” checkbox is checked. 

12)  Log out of MyBenU – For security reasons, log out of the system by clicking the 
“Sign Out” icon in the upper right hand corner of the page. 
 

Springfield Students: If you need assistance with the directions, please contact the Registrar’s 
Office (217) 525-1420 ext. 238.  If you need assistance with your ID or username not working, 
please contact the BU help desk (630) 829-6684. 
 
 
Withdraw / Drop Policy 
 
If you are admitted and drop prior to the start of your cohort, you will be waitlisted for a future 
cohort.  Should circumstances arise preventing you from completing your cohort, re-admission into 
a future cohort will be reviewed on a case-by-case basis. 

Incompletes 
 
Students who are doing passing work but who fail to complete all course requirements on a 
timely basis due to illness or other circumstances beyond the students' control, may petition 
the instructor for the grade of “I”.  As a general rule, a student petitioning for the incomplete 
should have completed at least 75% of the course work. This petition must be agreed upon 
and signed by both the faculty member and the student and delivered to the Registrar’s 
Office before the last class meeting.  The student who subsequently fails to complete all 
course requirements by the stated time (determined by the instructor), will have his/her 
grade of “I” changed to an “F”.    Arrangements for the "I" grade must be made before the 
final class meeting and/or the final exam.   Incompletes are not provided merely because a 
student is pressed for time. 
 
Application for Graduation 
 
Students applying for graduation must complete an application. Application deadlines are 
published each year in the University master calendar. Note that you must submit your 
application nearly eight to nine months in advance of your graduation date.  
 
The completed application for graduation form and processing fee may be submitted to 
Benedictine Central. Application forms with current due dates are available on the 
Department website at http://www.ben.edu/nursing.  
 
Springfield Students:  Current graduation application deadlines are 12/1/09 for Fall 2009 
and Spring 2010 graduates and 7/15/10 for Summer 2010 graduates. See the Registrar for 
further information. 
 



 

10            
6/30/09 

Benedictine University Student Academic Honesty Policy  
       
The search for truth and the dissemination of knowledge are the central missions of a 
university. Benedictine University pursues these missions in an environment guided by our 
Roman Catholic tradition and our Benedictine heritage. Integrity and honesty are therefore 
expected of all University students. Actions such as cheating, plagiarism, collusion, 
fabrication, forgery, falsification, destruction, multiple submission, solicitation, and 
misrepresentation are violations of these expectations and constitute unacceptable 
behavior in the University community.  
 
All nursing course syllabi include academic honesty statements. For a full description of the 
policy including student’s responsibilities, authority of the faculty, violations, and reporting 
and communicating please see http://www.ben.edu/ahp. 
 
 
Course Absence Policy 
 
Students are required to attend all classes. Guidelines on attendance are found in course 
syllabi. Note that attendance and class participation are not the same. 
 
Emergency Class Cancellations 
In the case of inclement weather, unsafe conditions, absence of an instructor, or other 
unforeseen situations, classes are usually postponed rather than cancelled. The University 
will post Lisle campus emergency information for Lisle students at: 
http://www.emergencyclosings.com/ecc/home.jsp .  
 
In Springfield, for the RN to BSN students, if the instructor determines there is an 
emergency reason for cancelling, he/she will post a message on Blackboard and/or email 
the students by 3PM.  If students are unsure, check email and Blackboard. 
 
In cases of inclement weather, you may also telephone Public Safety at (630) 829-6122 or 
in Springfield, the Benedictine University switchboard 217-525-1420 after 4PM.  The 
University will also notify the following radio and television stations with Emergency Closing 
information. 

Radio Stations:    TV Stations: 

For Lisle    For Lisle 
• WMAQ  AM 670   *  CBS *  NBC 
• WGN AM 720   *  CLTV *  WGN 
• WBBM  AM 780   *  FOX 

     
 For Springfield:   For Springfield 

• Capital Radio Group  *  WICS 
• Midwest Broadcasting  *  WAND 
• Neuhoff Media   *  WCIA 

      
Canceled classes may need to be rescheduled, depending upon the nature of the learning 
that was missed.  The faculty member will confer with the department chairperson as 
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needed about alternative meeting times (sometimes established by administrative areas in 
the University). 
 
Conflict Resolution Procedure 
 
The Benedictine University Student Handbook linked from the department website 
describes the academic appeals and academic honesty policies, the procedures for a 
grade appeal, and conflict resolution (grievance) policies and procedures.    
 
If a nursing major wishes to proceed with a complaint regarding an academic dispute of any 
nature (for any course), he/she should proceed in the following sequence for the most 
efficacious response. A written record of all communications should be maintained 
throughout the process by the student, as it would be required in the event of an appeal. 
The student proceeds to the next level, if the prior level does not resolve the complaint. 
 
 

1. Communicate directly with faculty member. 
2. Communicate with academic advisor. 
3. Communicate with Department Chair. As requested, the Department Chair 

communicates, in writing, the appeal process.  
4. File a written notice of appeal providing the needed documentation per the 

request of the Department Chair (e.g., unadulterated electronic file and paper 
copy of assignments or projects in question, original grading rubrics completed 
by instructor, written explanation). 

5. Meet with Department Chair. 
6. Meet with Dean of the College of Education & Health Services or designate. 

  
 
 
Student Resources/Services 
 
Organizations and Committees 
 
Sigma Theta Tau, International Honor Society of Nursing  
 
Benedictine University received a charter for Lambda Upsilon Chapter at Large in 1990. 
This society recognizes scholarship and leadership in nursing. Nursing research and 
publications are promoted through chapter activities.  To be eligible for membership you 
must have a minimum GPA of 3.0, rank in the upper 35 percent of your class, and have 
completed at least one half of the nursing curriculum. Inductions are scheduled yearly in 
the fall. 
 
Student Advisory Committee 
 
The Department has a Student Advisory Committee to provide student participation in 
governance. The Committee participates in the review and planning of curriculum 
components and reviews and makes recommendations regarding student welfare issues. 
To accommodate the multiple demands on students’ time, the Committee is available in 
“virtual” form and is accessed via WebCt/Blackboard account.  
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Academic Assistance 
If you need academic assistance, do not hesitate or wait!  
 
The Student Success Center (SSC) in Lisle and Student Resource Center in Springfield 
provide a variety of programs and services to support students' academic development at 
Benedictine University. These include:  

•   Individual Tutoring and Support  
• Study Sessions  
• The "Study Zone"  (Lisle) 
• Structured Learning Assistance Program (Lisle) 
• Accommodations for Disabilities  
• "Advising Matters" web site 
•  “Smart Thinking” (Springfield) 
• 24-hour online tutoring (Springfield) 

 
The Student Success Center (SSC) is located in Krasa Center, Room 012, 630-829-6340 for 
the Lisle Campus, and at the Resource Center located in Becker Library lower level, 217-525-
1420 ext 233 for the Springfield Campus. 
 
If the problem relates to a course, immediately discuss the problem or situation with your 
instructor. Contact information for your instructor can be found on your syllabus. If the 
problem is not satisfactorily resolved or is related to major or graduation requirements, 
please discuss the issue with your academic advisor (and refer to Conflict Resolution 
Procedures). 
 
 
Financial Aid, Scholarships and Loans 

Many opportunities exist for BSN students in need of financial assistance. Grants, low 
interest bank loans, or scholarships may be available from the government, corporations, 
community or civic groups, philanthropic and religious organizations, and Benedictine 
University. The Department website, http://www.ben.edu/nursing, provides a link to 
financial aid and scholarship opportunities.   

It is the responsibility of each student to consult with a Benedictine Central or financial aid 
representative about the guidelines regarding qualification and application of financial aid.  
 
In general students must be degree-seeking and carry a minimum of five (5) credit hours 
per term in order to potentially be eligible for financial aid. The level of aid awarded can be 
impacted by the number of credits a student carries in a given semester.  
 
In order to receive financial aid students must complete a FAFSA form, and have their 
information (via the FAFSA) sent to Benedictine University. The university school code is 
001767.  
 
Students can access and complete the online FAFSA form at www.fafsa.ed.gov. Students 
must also complete a Benedictine University financial aid application, available at: 
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http://www.ben.edu/resources/financialaid/documents/2007 2008_BU_FA_application.pdf . 
Students should print and submit the completed university form. 
 
The Financial Aid Office on the Lisle campus is located on the first floor of Lownik Hall 
room 157, e-mail financialaid@ben.edu, (630) 829-6100  
The Financial Aid Office at Springfield, Illinois, is located on the first floor of Dawson Hall, 
Room D112, or e-mail jnegro@sci.edu, or call 217/525-1420, ext. 244. 
 
Note: If you are receiving financial aid and are exempt from a course in the cohort 
sequence, you need to file a leave of absence (LOA) form.  When you signed your 
enrollment form, a Leave of Absence was automatically requested for major/ cohort 
courses from which you are exempt.  Check your enrollment form to ensure those courses 
were listed in the LOA box. 
 
University Web Site / Technology  
All students are expected to navigate the University web site at http://www.ben.edu. 

All students who are registered for classes at the University receive a user account.  This 
account allows a student to access the Benedictine network, MyBenU, BU’s Student 
Information System, off campus via BenUConnect, and the BU email system. For a 
complete Technology Information Packet, please see  
 http://www.ben.edu/it/docs/TIPS.doc    
Tutorials for MS Word, MS Excel, and MS PowerPoint are available online at:  
www.ben.edu/resources/tutorials . 
 
E-Mail Policy 
The Department will use the BU/ (SCI) student email system as a primary method to 
communicate information. It is your responsibility to check your Benedictine University/ or SCI 
email account on a frequent basis to insure you are aware of all updates.  Instructors will inform you 
if they intend to use personal or work emails as a primary communication method.   
 
For 24/7 assistance with technology problems contact the Helpdesk at 630-829-6684 
or Jason Arnold in Springfield at 217-525-1240, ext. 304 during normal business 
hours. 
MyBenU http://www.ben.edu/MyBenU/ 
Features available include: 
• Enroll in a course  (Lisle students only) 
• View address/e-mail information 
• View grades 
• View class schedule 
• View transfer credit report 
• View unofficial transcript 
• Registration procedures 
 
Academic forms are located online at: 
www.ben.edu/advising/tradundergrad_acad_forms.asp .  These include forms to: 
• Apply for Graduation 
• Gain Approval of Transfer Credit 
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• Request Independent Study  
• Request an Incomplete 
 
 Also available are: 
• FERPA (Family Educational Rights and Privacy Act) Form 
• Confidential Release  
 
Academic resources can be found online: 
www.ben.edu/advising/tradundergrad_acad_docs.asp . These include information about: 
• Core electives 
• Cultural Heritage courses 
• Athletic eligibility 
• Using BenULive 
And a variety of other helpful resources. 
 
The current and next term course schedules and availability are posted online at BenULive: 
http://www.ben.edu/benulive/ However, the most up-to-date information is in the PeopleSoft 
live registration system. 
 
The Academic Calendar is online:  
http://www.ben.edu/news/events/academic_calendar.asp. 
 
For Department of Nursing and Health related resources please check our homepage at 
http://www.ben.edu/nursing/. 
 
Finding Your Course Syllabus from the University Website 
 
A course syllabus is available on the BU Website two weeks prior to start of each course. 
To access syllabi go to the Department web page www.ben.edu/nursing  to Syllabi and 
Pre-Class Assignments, to Subject Category and hit that drop down arrow to reach Nursing 
and Health and then the View button; or you can go to www.sci.edu, and click on A.B.L.E. 
in the middle of the homepage.  Then click on Current Students at the top of the ABLE 
Page and choose Syllabi from the drop down menu.  Then scroll down to Bachelors and 
BSN and your cohort # and course.  Click on that for the syllabus.  
 
It is the student’s responsibility to access the syllabus prior to class start.   
BSN Classes often require a pre-class assignment due in the first class session.  It is 
essential to obtain your course syllabus overview from the University Website, which 
describes this pre-class assignment. The instructor will distribute the official course syllabus 
to each student during the first class meeting. 
 
 
Library Services 
http://www.ben.edu/library 
 
Circulation ................................................................................................. (630) 829-6050 
Reference .................................................................................................. (630) 829-6057 
Springfield Circulation ................................................................ (217) 525-1420, ext. 235 
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BU’s Lisle Library, located on floors 2-5 of the Kindlon Hall of Learning, provides more than 
160,000 bound periodicals and thousands of electronic data bases and additional 
resources for students.  All students must establish an individual Benedictine University 
Library ID, available on line. As BU students you will have access to the library resources at 
COD and Triton. A link to the BU’s Library as well as a Guide to Library Nursing Resources 
is available through the Department’s webpage.  
 
Springfield students have access to the library at Memorial Medical Center and the library 
at BU in Lisle through the Library on the Springfield campus.  BU-Springfield’s library is 
located on the first floor of Becker Library. 
 
 
Policy for Use of Edited Standard Written English* 

  

The BSN program requires that papers be written in edited standard written English 
(ESWE) and APA format (see below) 
 
Suppose a group of people were living on an island, all using the same language, until one 
day the island broke in two, separated by impassable water.  In one hundred years, with no 
contact, would the people on both halves still use the same language forms?  No.  Human 
language is always changing.  Language on each half of the island would evolve with 
different forms and rules.  Neither would be better in any absolute sense-just different.  
Similarly, in the United States, language variations have developed among people 
separated by culture, socioeconomic status, or geography. 
 
However, the language of the ruling class commonly comes to be regarded as standard.  In 
the United States, the “standard” is the language of the white middle and upper classes.  
Forms of English developed by people of color and by people who have been poor or 
geographically isolated (as in Appalachia) are sometimes said to be “bad” or “incorrect” 
English, but such forms are only different, not bad.  Each form of English has its own rules.  
People who say “she working” are not speaking “bad” English; they are using a different set 
of rules for forming the present tense.   
 
One of the tasks of a good education is to make students aware of these facts about 
language.  Another task of education, however, is to prepare students to function effectively 
in the world where readers generally expect writers to use Edited Standard Written English 
(ESWE).  (Thus, in this class, you must use ESWE.  Here is the standard I will apply.) 
 
On finished, final, formal papers (not on drafts, in-class writings, or writing that I 
specifically label as informal), you must have no more than an average of two departures 
from ESWE per page, in any combination of the following areas: 
 

·     End-of-sentence punctuation (avoid run-on sentences, comma splices, fragments, 
or misuse of semicolon).  Occasionally you may use a fragment or comma splice for 
a special effect.  Label it in the margin. 

·     Verb forms (use ESWE rules for adding -ed and -s, for using helping verbs, and so 
on). 

·     Verb tense (avoid confusing shifts in verb tenses). 
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·     Agreement of subject and verb. 
·     Pronoun form (use ESWE rules to choose between I and me, she and her, who and 

whom, and so on). 
·     Agreement of pronoun with antecedent (the antecedent is the word the pronoun 

refers to). 
·     Use of apostrophe s and the suffix -es. 
·     Use of quotation marks for all quoted words. 
·     Spelling (a typo counts as a misspelling). 
·     Proper sentence sense (no words omitted, scrambled, or incomprehensible). 
 
*From Barbara Walvoord.  Effective Grading: A Tool for Learning and Assessment.  

Eds. Barbara E. Walvoord and Virginia Johnson Anderson.  San Francisco: Jossey-
Bass, 1998. 

 
Another writing resource is located at:  St. Martin’s Exercise Central 
(http://bcs.bedfordstmartins.com/exercisecentral/default.asp?uid=0&rau=0) on the Writing 
Program website: http://www.ben.edu/programs/centers_institutes/writing/.  The exercises 
are a highly effective way to test your skills and improve mechanical weaknesses in your 
writing. 

 

APA Style Format 
 
The BSN program requires the American Psychological Association (APA) format and 
citations for written work.  The Concise Rules is a required reference text for the entire 
program.  You will find examples on the APA website: www.apastyle.com.  Resources for 
APA format are available at http://owl.english.purdue.edu/owl/resource/560/01/ and also 
through the Guide to Library Nursing Resources linked through the Department web page. 
 
Textbooks and Course Materials 
 
A list of books used in the program is linked to the Department website. Textbooks are 
available in BU’s bookstore on the first floor of the Krasa Student Center. You can order 
your books on-line at the on-line website: www.whywaitforbooks.com or via phone @ 630-
829-6010.  
In Springfield the Bookstore is on the lower level of Dawson Hall or call 217- 525-1420, ex. 
225. 
 
 
Updating Contact Information 
 
Update your contact information by printing, completing, and submitting the form to 
Benedictine Central:  http://www.ben.edu/forms/change_of_student_information_form.pdf 
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BENEDICTINE UNIVERSITY CHECKLIST FOR 
BACHELOR OF SCIENCE in NURSING 

ENROLLMENT RESTRICTED TO REGISTERED NURSES 
 (2009-2010 Academic Year) 

 

NAME: DATE: 

BU ID #: ADVISOR: SEMESTER OF ENTRY: 
 
GRADUATION REQUIREMENT:  Students must submit a total of 120 semester credit hours (with a minimum G.P.A. of 2.0 from Benedictine 
University courses)  
of which 55 must be completed at a four-year regionally accredited college and at least 30 semester hours, including 12 credit hours at the 200+ 
level in their major field, must be from Benedictine University.  
 

 
BASIC SKILLS: 12 hours  (“C” or higher required) 
College Course Cr Gr  
  3  WRIT-101 Writing Colloquium 
  3  WRIT-102 Research Writing 
  3  SPCH-110 Basic Speech 

  3  

Finite Math (MATH-S105) or 
College Algebra (MATH-S110) or 
Quantitative Reasoning (MATH-
S108) or proficiency via NRHL-250 

 
HUMANITIES: 9 hours (three courses from at least two of the areas of 
communications, literature, foreign language, fine arts, history, 
philosophy or religious studies). See Note # 11 on pg. 2 
College Course Cr Gr  
     
     
     
     
(3 semester hours may be satisfied by completing a core approved Ethics 
course – see the cognate requirements below) 
 
 

 
COMMON CORE: 6 hours 
  3  HUMN-220, 230 or 240 
  3  HUMN-250- WI 

 
SCIENCES: 6 hours (one course from the physical sciences and one 
course from the Biological sciences) See Note # 11 on pg. 2 
College Course Cr Gr  
     
     
     
(All 6 semester hours may be satisfied by major/cognate requirements below) 

 
SOCIAL SCIENCES: 9 hours (three courses from at least two of the 
areas of business, economics, anthropology, political science, 
psychology and sociology) See Note # 11 on pg. 2 
College Course Cr Gr  
     
     
     
     
(All 9 semester hours may be satisfied by major/cognate requirements below) 

_________________________________________________________________________________________________________________________________ 
      

MAJOR COURSES*: 
 

Accelerated BSN courses are to be completed within one calendar year. If transfer credit is accepted for any of the below requirements***, students 
receiving financial aid must submit a leave of absence for the exempted module(s). 
College Course Cr Gr  College Course Cr Gr  
BU  3  NRHL-200 Nursing Transitions***   3  NRHL-300 Holistic Nursing 
  3  NRHL-213 Health Aspects of Aging   4  NRHL-301 Family Health Nursing** 

  3  NRHL-250 Statistics   3  NRHL-311 Community Heath 
                 Nursing** 

  3  NRHL-295 Research   3  NRHL-320 US Health Care System 
  3  NRHL-290 Health Assessment**   3  NRHL-378 Management** 

 
*All major courses must be completed with a grade of “C” or better 
**Clinical / Lab / Fieldwork component  
***Must be taken at Benedictine University. Transfer credit will not be accepted for this course. 
Accredited by the Commission on Collegiate Nursing Education (CCNE)  
Sigma Theta Tau, International Lambda Upsilon at Large Chapter 

COGNATES: 
College Course Cr Gr  College Course Cr Gr  
    General Ethics     Chemistry 
    Intro to Psychology     Human Anatomy 
    Intro to Sociology     Human Physiology 
    Developmental Psychology     Microbiology 
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CREDIT GRANTED THROUGH ALTERNATIVE MECHANISMS: 
          

Excelsior 
College Exams 

Adult Nursing 
# 554 
 

8 cr   

 
MCH Nursing 
baccalaureate # 457 
 

8 cr   

 
Psych/Mental Health 
Nursing  
# 503 

8 cr   

     

NOTES: 
 
 
 
 
 
 
 

HIGHEST LEVEL OF MATH COMPLETED [if appropriate]:         
 
TOTALS: 

 
Hours 
completed 

Hours 
Remaining   The following semester hours will be posted on your transcript: 

Basic Skills 
      

Common Core 
      

Arts & 
Humanities      

Natural 
Sciences      

Social Sciences 
      

Lower Level 
Nursing credit                                        

Major 
 * *    

Electives 
                   *                   *    

TOTAL 
                    *    

 
Special Notes: 
 1. Hours in progress are not included in the totals of this evaluation. Additional hours will be credited upon receipt of credentials. 
 2. We do not apply grades of “D” toward a major or Basic Skills or toward some other courses as stated in the university catalog. 
 3. Double credit will not be given for repeated courses. 
 4. Only courses taken at Benedictine University will be included in the grade point average. 
 5. This checklist is applicable for the major indicated. If a different major is chosen, the requirements for both the major and core will vary. 
 6a. To be considered for Latin graduation hours, you must complete 55 undergraduate semester hours at Benedictine University. 
 6b. Students who complete 30 to 54 hours with a 3.5 cumulative grade point average at Benedictine University will graduate “with Honors”. 
 7. 55 semester hours at the Baccalaureate level must be completed at a four-year regionally accredited college/university. 
 8. Courses taken at Benedictine University may be repeated only at Benedictine University. 
 9. A minimum of 30 semester credit hours must be earned from coursework at Benedictine University. 

10. A minimum total of 120 semester credit hours are required for graduation (with a minimum cumulative G.P.A. of 2.0 from Benedictine University)  
      of which 45 semester hours, including twelve 200+ level semester credit hours in the major field, must be from Benedictine University. 
11. Equivalent transfer courses, if taken prior to admission, may meet core requirements.  Any course taken to fulfill core requirements after  

admission to Benedictine must be a core elective course (labeled with a “C” in the Catalog or course schedule) or an IAI core course.  Written 
permission is required for current Benedictine students to transfer in courses from other schools.  See your advisor. 

 
 
 
__________ ________ _______________________________  ___________________________________________ 

      Date  Transfer Credit Evaluation and Articulation  Department Chair 
         See the Department Chair for evaluation of major credit. 
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Bachelor of Science in Nursing (RN to BSN Completion) 

Student Plan of Study 

 

Student Name__________________________________________________   ID #________________________ 

Date ______________________   Cohort #__________________________ 

 

Courses Taken in cohort:    ____________ credits 

 

Remaining Courses:  _________________________________________________________ 

    _________________________________________________________ 

    _________________________________________________________ 

    _________________________________________________________ 

 

55 Baccalaureate Credits: ___________________ 

 

 

120 Total Credits: ___________________________ 

 

 

 

 

Advisor: ________________________________ Student: ________________________________________ 

 
 

 


